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Final Cut Pro X and AJA

 

Introduction

 

Final Cut Pro X is the latest update for Apple's popular non-linear editing software. It 
features a new user interface and boasts new, exciting features for editors. However, 
the way editors interact with third party tools, like the AJA KONA cards, Io XT and Io 
Express, is different from the previous versions of Final Cut Pro. This document 
describes how editors can use AJA products with the latest version of Final Cut Pro.

 

Note:

 

The information in this bulletin applies to Final Cut Pro X version 10.0.3 and 
AJA Version 

 

10.2 X Beta

 

 driver software for KONA, Io XT and Io Express.

 

AJA Recommendations for Configuring Your Final Cut Pro X System

 

You may want to use Final Cut Pro X right away, but you are likely to have some 
projects that you are still working on using a previous version of Final Cut Pro. AJA 
recommends that instead of installing Final Cut Pro X alongside your current version 
of Final Cut Pro, you create a new boot drive for your computer with a clean Lion OS 
install, then install Final Cut Pro X to this alternate boot drive. This way, you can 
continue to work on your older version of Final Cut Pro with your AJA products as you 
have been and begin to work on the new Final Cut Pro X. This will give you the most 
flexibility if you find you need to use the older or newer version of Final Cut Pro. 

 

Note: 

 

with respect to the system configurations required for AJA products, refer to 
the AJA documentation available on the AJA website. For the recommended system 
requirements for using Apple Final Cut Pro X, refer to the Apple website.
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Using AJA Products with Final Cut Pro X

 

Ensure You Have Current AJA Software

 

Ensure you’ve downloaded and installed the very latest current AJA Driver software 
for your product that supports Final Cut Pro X. Go to the AJA website support 
section to get that software:

     

 

 http://www.aja.com/support/

 

Launch the AJA Control Panel

 

Go to your Applications folder, locate the AJA Control Panel, and then run it.

 

Go to the Format Tab

 

Set the format and frame rate in the Format tab for the output format/frame rate 
you'd like to obtain from FCP X.
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Working with Final Cut Pro X and AJA — Using AJA Products with Final Cut Pro X

 

Go to Final Cut Pro X Preferences and Verify AJA A/V Output

 

In Final Cut Pro X, go to the Final Cut Pro pulldown menu and select Preferences.

Locate the A/V Playout pulldown menu in Playback Preferences, and note that 

 

A/V Output 

 

reports the AJA hardware. For example: AJA 1920 x 1080 @23.98.

If the video output from Final Cut Pro X and the AJA hardware is not appearing 
on a baseband connected broadcast monitor, first scrub over a clip in an Event, or 
in the Project. 
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If video out still does not appear, go to the Final Cut Pro Window pulldown menu 
and ensure that A/V Output is selected.

Final Cut Pro video output is set based on the Project. If you need to change from a 
23.98 output to a 29.97 output, you may need to quit Final Cut Pro X, change the 
format in the AJA Control Panel application and relaunch Final Cut Pro X. For ease 
of use, and clarity about the selected video output format and frame rate, you may 
keep the AJA Control Panel application open when working with Final Cut Pro X.
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Working with Final Cut Pro X and AJA — Using AJA Products with Final Cut Pro X

 

How to Set Sound for the Desired Output

 

The AJA KONA, Io Express and Io XT products are Core Audio compliant so you can use 
them to output system sounds or audio from a variety of applications. In order to 
enable this, you will need to open the System Preferences>Sound.

Once you have selected Sound, you can then select a device for the sound output.  
Choose the AJA device listed in the Output list.  

You have now made the appropriate video and audio selections for previewing video 
using your AJA KONA, Io Express or Io XT during editorial using Final Cut Pro X.  
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Capturing Clips for use in Final Cut Pro X

 

AJA VTR Xchange and Final Cut Pro X

 

One of the changes to the latest version of Final Cut Pro is the absence of Log and 
Capture within the application. For several years, AJA has offered a free application 
for capturing clips called AJA VTR Xchange. AJA VTR Xchange, as the name implies, is 
a program that allows users to ingest and output to VTRs. This simple-to-use 
application can be used to capture clips for use with the new Final Cut Pro X. The 
latest version of AJA VTR Xchange offers batch capture capabilities so users can log 
clips and capture them just as they used to with the Log and Capture tool found in 
previous versions of Final Cut Pro.

 

Note:

 

 AJA VTR Xchange can be downloaded as a stand-alone application from the 
AJA support pages for your product. Also note, AJA VTR Xchange only works with 
AJA devices, so it can not be used to capture from FireWire based cameras or VTRs. 
Always ensure you have downloaded the very latest version of AJA VTR Xchange.

 

Important:

 

 Installing Codecs Before Using VTR Xchange

 

Another difference between previous versions of Final Cut Pro and the new 
Final Cut Pro X is that additional codec support is not installed when you install 
Final Cut Pro X. To install additional codecs for use in Final Cut Pro X, such as the 
Apple ProRes family of codecs, you will need to perform a 

 

Software Update

 

 (from 
under the Apple icon in the finder) after you have installed Final Cut Pro X 

 

and before

 

 
using VTR Xchange. You will be installing the ProAppsQTCodecs.pkg from Software 
Update.

 

Note:

 

 it is very important that you should perform this step prior to using VTR 
Xchange for capturing clips for use in Final Cut Pro. If the additional codecs from 
Apple are not installed, a very limited number of QuickTime codecs will appear in the 
AJA VTR Xchange application.
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Working with Final Cut Pro X and AJA — Capturing Clips for use in Final Cut Pro X

 

Configuring AJA VTR Xchange

 

By default, the AJA VTR Xchange application, when it launches, will try to auto-
configure the main UI viewer so that you see a preview of your incoming video.    

What is auto-configured may or may not be what you want to capture, so you will likely 
need to make changes in the Capture>Video Settings and the Capture>Audio settings. 
Capture can be found in the Finder pulldown selections for the application.
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In most cases, you will likely want to capture to one of the Apple ProRes codecs for 
use within Final Cut Pro X. To configure the AJA VTR Xchange application to capture 
to one of the Apple ProRes codecs, go into the Capture>Video Settings selection and 
choose the Source tab first. Within Source, you will see a list of format types. Since 
Apple ProRes codecs are 10-bit, you will want to choose the appropriate format with 
the 10-bit indication—for example, 1080i 29.97 10 Bit (1920x1080).

Next, you will be selecting the type of compression that you want to work with: 
Apple ProRes 422, Apple ProRes 422 (HQ), etc. Click on the Compression tab of the 
Video Settings window.
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Working with Final Cut Pro X and AJA — Capturing Clips for use in Final Cut Pro X

Once you have selected the Source and the Compression, click OK in the lower right 
hand corner of the window.

The next step in configuring your settings is the Capture>Audio Settings. Again, select 
Capture from the Finder pulldown and then Audio Settings.

Once you have opened the Audio Capture Settings window, 
you can elect to change the number of audio channels you 
will capture, whether they are dual mono or stereo and what 
format of audio is used.  
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Once you have made the settings appropriate for your project, click OK in the lower 
right corner of the window.
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Working with Final Cut Pro X and AJA — Capturing Clips for use in Final Cut Pro X

 

Presets

 

Once you have set up capture settings, you can save them at any time by going to the 
Capture menu and selecting “Save current settings as a Preset..”.   This opens a dialog 
asking you to enter a name that the preset will be stored under for later recall.

 

Save Current Settings as a Preset

 

To manage your stored Presets, you can rename or delete them—also from the Capture 
menu.

To use a stored preset, simply select it from a pulldown menu at the bottom of the 
Capture window:

 

VTR Xchange, Main Window—View Current Preset or Select Another Preset
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Logging and Capturing Clips with AJA VTR Xchange

 

Before you begin logging and capturing clips, you will want to determine where your 
clips are saved. Go to the AJA VTR Xchange pulldown and select Preferences. On the 
Capture tab of the window, select a location for the Captured Clips Folder by 
choosing the Change button.  

 

Note:

 

 ensure you select a disk that has an adequate amount of storage space as well 
as adequate bandwidth capabilities for the type of codec, format and frame rate that 
you are trying to capture.

After you have selected the desired location for your clips, simply close the 
Preferences window.
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Working with Final Cut Pro X and AJA — Capturing Clips for use in Final Cut Pro X

The AJA VTR Xchange main window is very easy to operate. It consists of transport 
buttons for controlling your VTR (as well as familiar keyboard commands like J-K-L).  

You can shuttle through your material and mark an in and an out point and then use 
the log button to create a new Batch Capture List.
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Once you have logged all of your clips to the Batch Capture List, you can elect to 
capture them all at once. This is as simple as clicking on the Capture button in the 
lower right hand corner of the window.  

 

Note: 

 

if you want to log clips but perform the capture process later, an XML file is 
saved that can be opened and captured from later.  Once you have captured clips 
successfully, you can move on to working with them in Final Cut Pro X.
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Working with Final Cut Pro X and AJA — Clip Window

 

Clip Window

 

The 

 

Clip 

 

window gives information on the media that is captured, such as format. It also 
allows for marking an in-point for performing an edit to tape at a specific point, and 
selecting whether or not video, audio, and closed captioning will be included when the 
edit is performed.

 

Clip Window

 

The Clip Window allows you to output compatible framerates by enabling a checkbox 
at the bottom of the window. In order to output 23.98fps material at either a 
compatible 29.97fps or 59.94fps (depending on format), enable the checkbox. 

Another feature of the Clip Window is the ability to add audio tracks to an output by 
clicking on the “add audio tracks” button.  Audio tracks from another QuickTime movie 
file or AIFF audio files may be used.  Once tracks are added, the number of audio 
channels reported in the UI will increase accordingly. Once the “audio routing” is 
clicked, you can then use the audio routing tool to decide which tracks go to which 
physical outputs (see “Working with Audio” earlier in this manual).  This functionality 
can be particularly useful when working with audio which has been assigned 

 

Roles

 

 
from Apple's Final Cut Pro X software or when receiving audio tracks from a digital 
audio mixing or sweetening application that need to be married to the picture for 
mastering back to tape.
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Importing Clips into Final Cut Pro X

 

Importing Clips into Final Cut Pro X

 

Final Cut Pro X imports media differently than the previous versions of Final Cut Pro. 
Final Cut Pro X allows you to import your clips to an Event. By default, the name of the 
event is the current date. You can elect to change this name to whatever you feel 
serves your project organization best. You create a New Event via the File pulldown 
menu and choosing New Event. Once presented with the Event, name it accordingly 
and then choose the Import Files icon presented in the user interface. 
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Working with Final Cut Pro X and AJA — Importing Clips into Final Cut Pro X

Once you select Import Files, a prompt will appear which allows you to locate the clips 
you'd like to import. 

Final Cut Pro X provides a variety of selections that users can choose when importing 
media. Consult the Final Cut Pro X documentation to decide which settings are 
appropriate for your clips and your project. Once you have made the selections that 
you feel are appropriate for your needs, click on the Import button in the lower right 
corner of the window.

Once your clip is imported into Final Cut Pro X, it will appear in the Event you created.
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You can scrub, mark in and out points, assign keywords, etc. for your clip and add it to 
your project's timeline. Refer to the Final Cut Pro X documentation for details about 
editorial.

You can now create a New Project. Like the File Import, decide what settings are 
right for your project.
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Working with Final Cut Pro X and AJA — Exporting from Final Cut Pro X and using AJA VTR Xchange to Edit 

 

Exporting from Final Cut Pro X and using AJA VTR Xchange to Edit to Tape

 

Exporting Clips From Final Cut Pro X

 

Final Cut Pro X changes the way you output files to tape. In previous versions of Final 
Cut Pro, an Edit To Tape window was provided for this operation. With Final Cut Pro X, 
you first export a QuickTime Movie and then use AJA VTR Xchange to perform an edit 
to tape operation. 

 

Note:

 

 AJA VTR Xchange only performs insert edits, therefore, you need to be sure to 
black and code your tape prior to the edit to tape using the VTR's built in signal 
generators, striping the tape with the timecode required for your output.

With a timeline selected in Final Cut Pro X, choose the Share pulldown menu and select 
Export Movie. 

In most cases, you can leave the default values in the QuickTime Movie export window 
as is. If you want to change the settings, consult the Apple documentation for best 
practices and recommendations. Once you have made the desired settings, click on the 
Next button. After you click Next, you will be prompted to name the clip and then to 
save it. Be sure to export and save the clip to a disk with adequate space and 
bandwidth for the file type you are exporting. 

If you elected to have the clip open in QuickTime Player, review the clip before 
launching AJA VTR Xchange. If you feel there are any changes that need to be made, 
make them in your edit and re-export a QuickTime Movie if necessary.
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Using AJA VTR Xchange for Edit to Tape

 

Launch AJA VTR Xchange. From the File pulldown menu, select Open. Navigate to the 
location where the QuickTime Movie you exported from Final Cut Pro X was saved. 
Select the QuickTime Movie.

VTR Xchange will open a new Player window for the QuickTime Movie. 

You can review the QuickTime movie before you perform the edit to tape. Make the 
appropriate selections for the in and out points you want the edit to occur at as well 
as the audio routing. When you are satisfied with your selections, click on the edit to 
tape button on the right hand side of the user interface. Note: for detailed 
information on AJA VTR Xchange operation, refer to the AJA VTR Xchange manual.

After you perform the edit to tape operation, you can review your edit by using the 
VTR Xchange main UI window or you can review the edit directly from your VTR.
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Working with Final Cut Pro X and AJA — Using AJA Ki Pro Apple ProRes Recorders with Final Cut Pro X

 

Using AJA Ki Pro Apple ProRes Recorders with Final Cut Pro X

 

The Value of the AJA Ki Pro and Ki Pro Mini to Apple Final Cut Pro X Users

 

In 2009, AJA was the first company to introduce an Apple ProRes 422 video recorder, 
the Ki Pro. The AJA Ki Pro could be paired with a variety of camera to produce ready-to-
edit QuickTime Movies for use with Final Cut Pro. In 2010, AJA added the Ki Pro Mini, a 
more compact device, to this family of products. Both products are ideal for use with 
Final Cut Pro X because they can create QuickTime Movies that are native to Final Cut 
Pro X. Ki Pro and Ki Pro Mini files can be copied to your Final Cut Pro X editing system's 
storage and then imported into your Final Cut Pro X Events.
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Summary

 

A New Way of 
Editing

 

Final Cut Pro X introduces new ways of working to editors. Some of the items that are 
familiar to longtime users of Final Cut Pro have changed, but the flexibility of Final 
Cut Pro X is very compelling. Final Cut Pro X can be paired with AJA desktop products 
for ingest, editorial and mastering to tape in ways familiar to users. The AJA Ki Pro and 
Ki Pro Mini acquisition products can be used for the most modern file-based 
workflow possible when working with Final Cut Pro X. The workflows explained in 
this document are designed to help users with the transition to this new and exciting 
phase of Apple non-linear editing. As Apple's Final Cut Pro X evolves, expect AJA to 
provide new and exciting interactions with the software and expand the workflow 
possibilities.

If you have further questions beyond the scope of this brief overview document, 
consult Apple documentation for Final Cut Pro X, AJA documentation for the KONA 
and Ki Pro products. If you still feel you need assistance, don't hesitate to contact AJA 
Technical Support via phone or email.

Telephone: 800.251.4224 or 530.274.2048

Support Email: support@aja.com 


